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Preface

The Agile Product Lifecycle Management for Process Install/Upgrade Guide contains 
instructions for installing and upgrading Oracle Agile Product Lifecycle Management 
(PLM) for Process.

This preface contains these topics:

■ Audience

■ Variability of Installations

■ Related Documents

■ Related Documents

■ Conventions

Audience
This guide is intended for end users who are responsible for creating and managing 
information in Agile PLM for Process. Information about administering the system 
resides in the Agile Product Lifecycle Management for Process Administrator User Guide.

Variability of Installations
Descriptions and illustrations of the Agile PLM for Process user interface included in 
this manual may not match your installation. The user interface of Agile PLM for 
Process applications and the features included can vary greatly depending on such 
variables as:

■ Which applications your organization has purchased and installed

■ Configuration settings that may turn features off or on

■ Customization specific to your organization

■ Security settings as they apply to the system and your user account

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.
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Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
For more information, see the following documents in the Agile PLM for Process 
Release 6.1.1 documentation set:

■ Agile Product Lifecycle Management for Process Administrator User Guide

■ Agile Product Lifecycle Management for Process Global Specification Management User 
Guide

■ Agile Product Lifecycle Management for Process Supply Chain Relationship Management 
User Guide

■ Agile Product Lifecycle Management for Process Configuration Guide 

■ Agile Product Lifecycle Management for Process Release Notes. Up-to-date Release 
Notes and other documentation are posted on Oracle Technology Network (OTN) 
at this location:

http://www.oracle.com/technetwork/documentation/agile-085940.html#plmpro
cess

http://www.oracle.com/technology/documentation
http://www.oracle.com/technology/documentation
http://www.oracle.com/technology/documentation


xi

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.



xii
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1Installation Requirements

This chapter provides requirements that should be met prior to installation of Agile 
PLM for Process. Topics in this chapter include:

■ Checking for Latest Information and Instructions

■ Installation Requirements

Checking for Latest Information and Instructions
Prior to installation refer to the following URLs for the latest information and 
instructions:

1. Oracle Software Delivery Cloud: http://edelivery.oracle.com/. Oracle Software 
Delivery Cloud provides the latest copy of the core software. Note the core 
software does not include all patches and hotfixes.

a. Select appropriate language and click Continue.

b. Complete the export validation requirements form.

c. Select "Oracle Agile Applications" as the Product Pack.

d. Select "Microsoft Windows x64 (64-bit)" as the Platform.

e. Click Go.

f. Search for “Oracle Agile Product Lifecycle Management for Process 6.1.1.0.0 
Media Pack” in Results and select link.

g. Download the appropriate media packs.

2. Oracle Support:  https://support.oracle.com.  Oracle Support provides the latest 
patch releases and hotfixes. To gain access to the latest patches and hotfixes 
perform the following steps:

a. Log into  https://support.oracle.com. If you do not have a user ID, contact 
Oracle Support.

b. Select a language from the Language drop-down, and then click Sign-In. 

c. Go to Patches & Updates.

d. Under Patch Search, click "Product or Family (Advanced Search)".

– Product is "Oracle Agile Product Lifecycle Management for Process".

– Release is "{The release you are interested in}", i.e. "Agile PLM for Process 
6.1.1.0.0"

– Platform is "Microsoft Windows (64-bit)"
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e. Click Search. The latest patches and hotfixes will be provided in the search 
results.

f. Download the appropriate patch releases or hotfixes. 

3. Oracle Technology Network (OTN): 
http://www.oracle.com/technetwork/indexes/documentation/index.html. OTN 
contains documentation for Agile PLM for Process. 

a. Access 
http://www.oracle.com/technetwork/indexes/documentation/index.html.

b. Under the Oracle Applications section, scroll down to "Other Applications" 
and select the Oracle Agile link. A new window opens. 

c. Click Agile PLM for Process Documentation to see a listing of available 
documentation.

4. Oracle Mix:  https://mix.oracle.com/groups/16252. Visit the Prodika Lounge for 
the latest posts from customers, partners and Oracle’s Product Management 
regarding the PLM for Process product line.
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Installation Requirements
The Agile PLM for Process Software Requirements table shows the operating system 
and the other software supported or required for each component.

Software Requirements

Table 1–1 Software Requirements

Component Operating System Certified Software

Web Application Server Microsoft Windows Server OS that is 
supported by the certified software

■ IIS 7.5 on Microsoft Windows 2008 Server 
R2 64-bit

■ IIS 7.0 on Microsoft Windows 2008 Server 
SP1 32-bit/64-bit

■ IIS 6.0 on Microsoft Windows 2003 Server 
SP2 32-bit

.NET Framework Microsoft Windows Server OS that is 
supported by the certified software

Microsoft .NET Framework 3.5 + latest 
available service pack

Microsoft Database Server 
(Standard & Enterprise)

Microsoft Windows Server OS that is 
supported by the certified software

■ Microsoft SQL Server 2012 R2

■ Microsoft SQL Server 2008 R2

■ Microsoft SQL Server 2008 SP1 or higher

■ Microsoft SQL Server 2005 SP2 or higher

Oracle Database Server 
(Standalone and RAC)

Note: Oracle Standard Edition 
does not support RAC

Any server OS that is supported by 
the certified software

■ Oracle Database 11gR2 (ODP.NET client 
11gR2)

■ Oracle Database 11g (ODP.NET client 
11.1.0.6)

■ Oracle Database 10gR2 (ODP.NET client 
11.1.0.6)

ODP.NET Client Same as Application Server ■ Oracle ODP.NET 11gR2 for 11gR2

■ Oracle ODP.NET 11.1.0.6 for 11g

Note: Oracle does not support Oracle 11g 
client on Microsoft Windows 2008 Server R2

Microsoft SQL Reporting 
Services

Microsoft Windows Server OS that is 
supported by the certified software

■ Microsoft SSRS 2008

■ Microsoft SSRS 2005

Oracle BI Publisher Any server OS that is supported by 
the certified software

■ Oracle BI Publisher 11.1.1.7.0 + latest SP

■ Oracle BI Publisher 11.1.1.6.0 + latest SP

■ Oracle BI Publisher 11.1.1.5.0 + latest SP

■ Oracle BI Publisher 10.1.3.4.1

Web Client Browser Microsoft Windows OS that is 
supported by the certified software

■ Internet Explorer 9.0

■ Internet Explorer 8.0

■ Internet Explorer 7.0
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Hardware Requirements

Minimum Requirements
The following table shows the minimum hardware needed to deploy Agile PLM for 
Process.

Hardware Recommendations
The following table shows the typical hardware recommendations for production 
deployments of Agile PLM for Process.

Web Application Server Dual CPU Intel Xeon 3.0+ GHz

2 MB L2 Cache

4 GB RAM (8 GB if running application as 64-bit)

DB Server Dual CPU Intel Xeon 3.0+ GHz

2 MB L2 Cache

4 GB RAM

Separate drives for data and log files

Remoting Container Same as Web Application Server

Note: Remoting Container is lightweight and can be run on 
any existing application server.

Web Application Server Quad Core, Dual CPU Intel Xeon 3.0+ GHz

2 MB L2 Cache

8+ GB RAM

DB Server Quad Core, Dual CPU Intel Xeon 3.0+ GHz

2 MB L2 Cache

16+ GB RAM

Separate drives for data and log files

Remoting Container Same as Web Application Server

Note: Remoting Container is lightweight and can run on any 
existing application server.
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Scaling Requirements
You will need to scale your system for performance and availability as your system 
begins to grow due to an increased use of the Agile application suite and a growing 
number of users and as your business demands change or increase. The following 
sections provide basic scalability recommendations.

Scaling for Performance
You will need to scale for performance as the number of users and applications begins 
to increase over time. In consideration of performance scaling, we recommend the 
following:

■ No more than 500 registered users per core.

■ Organize scaling according to regional user patterns (according to users in similar 
time zones and geographical regions).

■ Once physical Web application server limitations are met, use a load-balanced 
(logical or actual) solution.

Scaling Beyond Six Core Applications
The following are recommendations for scaling beyond six (6) core Agile applications. 
Core Agile applications include:

– Global Specification Management (GSM)

– Supply Chain Relationship Management (SCRM)

– New Product Development (NPD)

– eQuestionnaire (eQ)

– Product Quality Management (PQM)

– Agile applications portal

■ Organize scaling based on an evaluation of utilization patterns (known application 
characteristics).

Load Balancing  As mentioned above, once physical Web application server limitations 
are met, use a logical load-balanced solution based on application distribution across 
servers. For example, a logical separation might be organized by application as 
follows:

GSMAppGroup — Includes GSM and other complimentary applications

NPDAppGroup — Includes NPD and other complimentary applications

Scaling for Availability
You may also need to scale for availability as your business demands begin to change 
or increase over time. 

For application load-balancing, we recommend the following:

■ A load balancer (such as f5 BigIP or Cisco CSS11000) that supports the following:

– Secure Sockets Layer (SSL) protocol

– Sticky sessions

■ A maximum of six core Agile applications per load-balanced node.
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For database, file, and service clustering, we recommend the following:

■ A clustered server to support an active or passive database system

■ A file cluster (where required)

Note: A clustered node is an expansion of a logical application 
separation.
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2Installation

This chapter discusses Agile PLM for Process installation and includes the following 
topics:

■ Pre-Installation Checklists

■ Installation

■ Post-Installation Checklists

Overview
Installing Agile PLM for Process involves several steps, including:

■ Understanding system requirements

■ Performing pre-installation tasks (such as setting up the Web application server 
and database)

■ Running the command prompt installation batch files

■ Performing post-installation tasks, such as:

■ Configuring the remote container service

■ Performing some base application environment configurations

■ Testing the installation

Note: Some tasks required to complete this installation are technical 
in nature. Refer to Appendix F, "Skill Set Requirements and 
Recommendations" for a list of skills recommended for completing 
tasks included in this guide.
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Pre-Installation Checklists
This section discusses Web application server-related tasks that an Agile implementer 
must complete before installing the Agile application suite.

The application is configured out of the box to use Integrated SSPI. This technology is 
used to ensure the username and password is not stored as clear-text in any 
configuration files and is only applicable to environments using Microsoft SQL Server. 
This guide will only refer to settings as they pertain to SSPI. Refer to the Agile Product 
Lifecycle Management for Process Security Configuration Guide for secure Oracle DB setup 
and unsecure clear-text method.
 

Pre-Installation Environment Configuration

User Creation
A local or domain application user needs to be created. The example user will be 
PLM4P_AppUser for the purposes of this document. PLM4P_AppUser will need 
access to the following:

■ Files

■ Read access to the PLM4P_HOME directory

■ Read/Write access to the PLM4P_HOME\logs directory

■ Read/Write access to the PLM4P_HOME\XDocuments 

■ Read/Write access to WebDAV directory for NPD

■ Read/Write access to system temp directory (i.e.. c:\windows\temp)

■ Full control over PLM4P_HOME\RemotingContainer

■ IIS

■ Identity for Application Pool

– For IIS 6.0, add user to IIS_WPG group

– For IIS 7.x, add user to IIS_IUSRS group

■ Service

■ Execute and Run the Remoting Container Service

■ MSSQL Database

■ db_datareader

■ db_datawriter

■ db_executor

Note: The clear-text method should ONLY be used in a 
non-production environment as your username and password is 
stored in clear-text in the configuration file.
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Microsoft Application Server Checklist
Before installing the Agile PLM for Process application suite, complete all of the 
Microsoft IIS related tasks in the following sections:

■ Add Application Server Role

■ Configure Microsoft .NET Framework

■ Create and Configure IIS Application Pool Settings

■ Create and Configure a Website

■ Enable WebDAV for NPD Applications

■ Enable IIS6 or Apache 2.2 for NPD Application

Add Application Server Role
Refer to Microsoft Windows Server documentation for deploying the server role, 
Application Server (IIS, ASP.NET). 

■ For Microsoft Windows 2003, install IIS 6.0. Post installation, in IIS Manager, under 
Web Service Extensions, allow ASP.NET 2.0.50727. 

■ For Microsoft Windows 2008, install IIS 7.x. During installation, be sure to select 
the following options:

■ ASP.NET

■ IIS 6.0 Management Compatibility

Post installation, in IIS Manager, under ISAPI and CGI Restrictions, allow 
ASP.NET 2.0.50727.

Note: XDocuments and WebDAV are configurable settings and may 
exist elsewhere within your environment. Once installed, refer to the 
Agile Product Lifecycle Management for Process Configuration Guide for 
location and details.
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Configure Microsoft .NET Framework
After installing Microsoft .NET Framework 3.5 SP1, you need make some 
configuration changes to the machine.config file for performance optimization 
purposes.

Make the following updates to the machine.config file as follows:

1. For 64-bit locate and open the machine.config file at:

C:\Windows\Microsoft.NET\Framework64\v2.0.50727\Config\machine.config

For 32-bit locate and open the machine.config file at:

C:\Windows\Microsoft.NET\Framework\v2.0.50727\Config\machine.config

2. Locate the system.web tag and add the following under it:

<processModel enable="true" timeout="Infinite"
idleTimeout="Infinite"
shutdownTimeout="00:00:05" requestLimit="Infinite"
requestQueueLimit="5000" restartQueueLimit="10"
memoryLimit="60" webGarden="False" cpuMask="0xffffffff"
userName="SYSTEM" password="AutoGenerate" logLevel="Errors"
clientConnectedCheck="00:00:05"
comAuthenticationLevel="Connect" comImpersonationLevel="Impersonate"
responseDeadlockInterval="00:03:00"
responseRestartDeadlockInterval="00:03:00" autoConfig="True"
maxWorkerThreads="20" maxIoThreads="20" minWorkerThreads="1"
minIoThreads="1" serverErrorMessageFile="" pingFrequency="Infinite"
pingTimeout="Infinite" maxAppDomains="2000" />

3. Add the following to the web.config file in the same folder as the machine.config 
file, configuration/system.web/authentication

        <authentication mode="Windows">
            <forms name=".ASPXAUTH" protection="None">
                <credentials passwordFormat="SHA1" />
            </forms>
        </authentication>

4. Open Internet Information Server Administrator and right-click on the Web virtual 
folder and choose Properties. 

5. Click on the ASP.NET tab to confirm that .NET 2.0 is selected.

Refer to Appendix B, "Verification Tests" for instructions on performing tests to verify 
the installation.

Note: A reference machine.config can be found in 
installer\tools\ directory.

Note: Sometimes, these tags might exist prior to this step. If these 
tags are already present, update them to look as above.
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Create and Configure IIS Application Pool Settings
Application Pool names are for example, and can be renamed if needed.

Create at least two Application Pools called PLM4P_MAIN and PLM4P_GSM with 
the following settings modified.

It is highly recommended that GSM is setup in its own Application Pool. Based on the 
applications installed and used in your environment, you can set other applications to 
use their own Application Pools in order to maximize memory allocation and 
performance.

Create and Configure a Website
Website name defined below is an example and can be renamed if needed.

Create a website called PLM4P with the application pool set to PLM4P_MAIN and a 
Physical path of 'C:\inetpub\wwwroot'. For a production environment, this site 
will need a valid SSL certificate to protect against data traversing the network in 
clear-text. Refer to the Agile Product Lifecycle Management for Process Security 
Configuration Guide for more information, as well as, information on how to setup 
without SSL for non-production environments.

Enable WebDAV for NPD Applications
If you are installing the Agile PLM4P NPD application, you must enable the WebDAV 
(Web Distributed Authoring and Versioning) protocol in Microsoft IIS to support 
in-place editing. Refer to Appendix C, "Installing WebDAV" for instructions.

IIS 7.x Setting IIS 6.0 Setting Value

Enable 32-Bit Applications N/A False

Managed Pipeline Mode N/A Classic

Queue Length Request queue limit 4000

Identity (Custom Account) Identity (Configurable) PLM4P_AppUser

Idle Time-Out N/A 0

Regular Time Interval Recycle worker process 0 (uncheck)

Ping Enabled Enable pinging False

Rapid-Fail Protection Enable rapid-fail protection False

Note: Identity can be set to Local System in non-production 
environments that are not utilizing Integrated SSPI for the DB 
connectstring. See the Agile Product Lifecycle Management for Process 
Security Configuration Guide for more information.

Warning: WebDAV is fundamentally different in IIS7.x and is not 
a supported platform when using an anonymous user. If you are 
installing the main application on IIS7.x, then you must have a 
separate web server with IIS6 or Apache 2.2 installed for WebDAV.
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Configure Microsoft SQL Server
Refer to Microsoft SQL Server documentation for installation instructions. For 
information on MS SQL Reporting Server, which can be optionally installed, refer to 
the Agile Product Lifecycle Management for Process Configuration Guide. When installing, 
ensure the collation designator and sort order are Latin1_General.

Oracle Database Server Checklist
■ Create the Oracle database server using Oracle Database Configuration Assistant.

■ Choose AL32UTF8 as the database character set and UTF8 as the database 
national character set.

Oracle Database Client Checklist
The following Oracle Database Checklist can be used in conjunction with Oracle 
Database documentation containing installation instructions. Clients should use this 
checklist or the instructions in "Configure Microsoft SQL Server" on page 2-6, but not 
both, as they are separate installation methods. When installing the Oracle client, be 
sure to:

■ Install Oracle 11g Release (11.1.0.6 +) client on the server hosting the application. 

■ Update the tnsnames.ora, located at %Oracle Client 
Home%\network\admin\tnsnames.ora, to include a new data source. This data 
source should point to the Oracle database that was set up.

■ Build your connection string: 

“User Id=<user id>;Password=<password>;Data Source=<data 
source created in step 4>” where

a. User Id = db username

b. Password = passwd

c. Data Source = The name that you gave your tnsnames.ora entry

SSL Checklist
SSL (Secure Sockets Layer) is a protocol from Netscape Communications Corporation 
that is designed to provide secure communications on the Internet. SSL is not required 
for an Agile installation but is strongly recommended for production environments.

SSL can be deployed in many ways. Most commonly, SSL will run within IIS or on an 
intermediary system such as a Reverse Proxy or SSL accelerator.

The Agile application suite can operate in any of these scenarios, but the HTTP scheme 
must be configured (via environmentvariables.config) to generate the desired 
relative URLs correctly (http vs. https). The default URLs are configured for https. 

East Asian Language Support
If you plan to support East Asian languages in Agile Product Lifecycle Management 
for Process, you must install East Asian language support on the server.

To install East Asian language support on the server:

1. Access the Windows Control Panel dialog box by clicking Start > Control Panel.
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2. Select Date, Time, Language, and Regional Options > Regional and Language 
Options and click the Languages tab.

3. Check the Install Files for East Asian Languages box.

4. Click Apply and OK.

Restoring the SQL Database and Setup Database Accounts
A prepared database is provided as part of your Agile software media from Agile 
Software. Using Microsoft SQL Server Management Studio, you will need to restore 
this database onto your local database server. You will also need to make sure that the 
user responsible for accessing the database has the appropriate account setup and 
assigned roles.

Option 1: MSSQL Database

Restoring the Database  
Refer to Microsoft SQL Server documentation for restoring a database.  

The name and location of the database is <media pack>\Database\Certified_
DB_<version>.zip

 

Setting Up User Permissions  

Refer to Microsoft SQL Server documentation for setting up a user.  

Recall and add the user created as part of the pre-installation environment checklist.  
For example, PLM4P_AppUser.  At a minimum, this user must have the following two 
roles for the plm4p_ database:

■ db_datareader

■ db_datawriter

Option 2: Oracle Database
To restore the Oracle database:

1. Create an Oracle database user. A SQL script is provided to create the database 
user and set up user permissions for the application. Run the SQL script 
createuser.sql using Oracle SQL*Plus.

2. Note that the imp client version has to match exactly the Oracle database server 
version. The client character set also needs to be set to the server character set. 
Import the Oracle database dump file certifiedDB_v6100.dmp from the 
command window:

C:> set NLS_LANG=AMERICAN_AMERICA.AL32UTF8
C:> imp <ORCL dbuser>/<ORCL dbpwd>@<datasource> fromuser=<agile> touser=<target 
dbuser> file=<dmp file> log=<log file>

Note: If you do not already have a naming convention, it is  
recommend to include the environment name. For example: plm4p_
production.
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Installation
The Agile PLM suite is installed through a set of manual configuration steps. Several 
of the steps are automated with utility batch scripts for a default configuration. The 
overall process consists of the following steps:

■ Setting up PLM4P_HOME

■ Installing the Core Application Files

■ Registering Environment Components

■ Setting the Remote Container Service and Application Pool Accounts

■ Installing Individual Media Bundle Application Files

■ Setting Up the Initial IIS Application Pools

■ Register the IIS virtual directories for the installed applications

■ Registering .Net version 2.0 under ASP 

■ Installing the Reference Database

■ Installing Language Support for Simplified Chinese, Traditional Chinese, Korean, 
French, German or Italian

■ Configuring Applications

■ Installing BI Publisher (Optional)

■ Completing Optional Steps

■ Determining a Website’s Site ID

Installation Process

Setting up PLM4P_HOME

1. Create a folder (e.g. c:\PLM) into which to install the application. For instructional 
purposes, this folder will be called PLM4P_HOME.

Installing the Core Application Files

Throughout the instructions below, the place where you extracted the media bundle 
zip file will be referred to as INSTALLER_HOME.

1. After obtaining the media bundle, extract to a directory on the web application 
server.

Note: This step needs to be done only once per Web site instance. If 
you have multiple instances of the Agile PLM suite running on the 
same server, you will need to perform this step once per instance.

Note: This step needs to be done only once per PLM4P_HOME. If 
you have multiple instances of the Agile PLM suite running on the 
same server, you will need to perform this step once per instance.
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Throughout the instructions below, the place where you extracted the media 
bundle zip file will be referred to as INSTALLER_HOME.

2. Open the containing directory for INSTALLER_HOME.

3. Extract Core.zip located in INSTALLER_HOME\PDM (where PDM is the name of 
the media bundle being installed) to a temporary directory (i.e.; c:\temp). This will 
give you a directory structure like c:\temp\Apps, c:\temp\Config, etc. This 
temporary directory will be referred to as TEMP_HOME.

4. Copy FileCompressionHelper.exe from INSTALLER_HOME to TEMP_HOME.

5. Open a command prompt and navigate to TEMP_HOME (i.e.; >cd c:\temp).

6. Run the following: 

>FileCompressionHelper.exe -d

7. When the distribution is complete, move your TEMP_HOME contents to PLM4P_
HOME.

Registering Environment Components
1. Register event logs.  

a. Open a command prompt and navigate to INSTALLER_
HOME\Installer\Tools.

b. Run the following batch file:

>SetupEventLogs.bat

c. You will be asked to verify the addition of each event log to your system event 
logs. Click Yes/Ok through all of the event log additions.

2. Install the Remoting Container Service.

a. Open a command prompt and navigate to INSTALLER_
HOME\Installer\Tools.

b. Stop IIS. From the command prompt type the following:

>iisreset /stop

c. Run the following batch file with <PLM4P_HOME> replaced by your specific 
PLM4P_HOME directory:

>InstallRemotingContainerService.bat <PLM4P_HOME>

Warning: It is extremely important that you perform the 
decompression described in step 5 before continuing to install any 
additional media pack bundle files.

Note: This step needs to be done only once per PLM4P_HOME. If 
you have multiple instances of the Agile PLM suite running on the 
same server, you will need to perform this installation once per 
instance.
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Setting the Remote Container Service and Application Pool Accounts
The remote container service and application pool are standard Microsoft Windows 
services, which require user accounts in order to run. During the Agile installation, the 
service is installed as the Local System account.

To change the account which the service runs under:

1. Select Start > Administrative Tools > Services.

2. Locate the RemoteContainerService within the list of services listed in the Services 
dialog box.

3. Right-click the RemoteContainerService row and select Properties.

4. Select the Log On tab.

5. Select the This account radio button.

6. Select the PLM4P_AppUser account defined in the Pre-Installation section.

Before installing Agile PLM for Process, make sure that your IT department has 
created an account for each service for you. Such accounts can be system accounts, 
local Windows accounts, or domain accounts (active directory). The process for 
creating a remote container service account and application pool account is a standard 
approach for creating Windows accounts.

Installing Individual Media Bundle Application Files
1. Open the containing directory for INSTALLER_HOME.

2. Extract the media pack zip file located in INSTALLER_HOME to a temporary 
directory (i.e.; c:\temp). This will give you a directory structure like 
c:\temp\config, c:\temp\FileCompressHelper_CentralDirectory & c:\temp\Web.

3. Confirm media bundle names for the ZIP files, where the name can be one of:

■ MP1.zip for the PDM install

■ MP2.zip for the FC install

■ MP3.zip for the PSC install

■ MP4.zip for the NPD install

■ MP5.zip for the PQM install

4. Copy FileCompressionHelper.exe from INSTALLER_HOME to TEMP_HOME.

5. Open a command prompt and navigate to TEMP_HOME (i.e.; >cd c:\Temp).

6. For all of the media bundles other than the NPD media bundle, run the following 
utility application:

>FileCompressionHelper.exe -d

7. When the distribution is complete, move your TEMP_HOME contents to PLM4P_
HOME.

8. Accept the warning(s) to overwrite the directories that already exist.

Warning: If utilizing Integrated SSPI in the database 
connectstring, then the logon account for the remote container 
service needs to be a user with datareader and datawriter rights for 
the database.
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Setting Up the Initial IIS Application Pools
It is recommended that you run the suite of applications under multiple application 
pools in order to provide better resource management and security. At a minimum, 
GSM needs to be in its own application pool, segmented from the rest of the 
applications.

The utility scripts are designed to place the different applications under the same 
application pool, or you may run the SetupVirtualDirectories.bat file 
manually giving the values for the specific web applications to segment them as you 
see fit.

The general process of installing the necessary web applications using the utility 
scripts is listed below:

1. Open a command prompt and navigate to the directory INSTALLER_
HOME\Installer\Tools.

2. To install the core website virtual directories, choose one of the following options:

■ Option 1, Creating a single app pool—To install the core website virtual 
directories, type the following where the values <PLM4P_HOME>, <siteid> 
and <AppPool> are replaced with the values associated with your specific 
environment:

SetupCoreVirtualDirectories.bat <PLM4P_HOME> <siteid> <AppPool>

■ Option 2, Segmenting the applications into separate application pools—To 
manually create the virtual directories needed for the individual applications 
within the core application bundle, type the following. You will need to repeat 
this script for each of the different applications within core. Refer to the 
SetupCoreVirtualDirectories.bat file to determine the applications 
within core.

SetupVirtualDirectories.bat drl <siteid> <PLM4P_HOME> <AppPool> drl

3. Each media bundle has an associated 
Setup<MediaBundle>VitualDirectories.bat batch file where 
<MediaBundle> is PDM, FC, SupplierCollab or NPD. To install the necessary 
virtual directories for each installed media bundle, repeat the process outlined in 
step 2, replacing <Media Bundle> appropriately.

Note: This is a minimum application pool configuration. Depending 
on usage, it may be necessary to split out other applications into their 
own application pool.   

For a 32-bit .NET application running on a 32-bit OS, application pool 
memory should not exceed 800 MB. For a 32-bit .NET application 
running on a 64-bit OS, application pool memory should not exceed 
1.8 GB. 

Keep this in mind when determining how to separate your 
applications. Some examples of possible applications to separate 
include NPD, SCRM, and GSMView. 

Note: Refer to the section"Determining a Website’s Site ID" on 
page 2-14 to determine the value for <siteid>.
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Registering .Net version 2.0 under ASP
1. Open a command prompt and navigate to INSTALLER_HOME\Installer\Tools.

2. Run the following command:

>RegisterASP_2_0.bat

Installing the Reference Database
There is a reference database that is located under INSTALLER_HOME\Database. 
Restore this database to your database server by following the instructions outlined 
under the "Restoring the SQL Database and Setup Database Accounts" on page 2-7 and 
"Setting Up User Permissions" on page 2-7 section earlier in this guide.

Installing Language Support for Simplified Chinese, Traditional Chinese, Korean, 
French, German or Italian
As an optional step, customers may apply 6.1.0.0.0 National Language Support (NLS) 
installation. See Appendix D, "Installing National Language Support" for instructions.

Configuring Applications
Review the Agile Product Lifecycle Management for Process Configuration Guide to apply 
the configuration changes required for the installation.

Configuring the Oracle Database Connection  

To configure the Oracle Database Connection:

1. Update the Database URL in EnvironmentVariables.

Prodika.DB.URL = User Id=<user>;password=<Password>;Data Source=<datasource>

2. Add the Adapter Factory to EnvironmentSettings.config.

a. Open EnvironmentSettings.config.

b. Navigate to the <ProdikaDB> node under 
<EnvironmentSettings><Core><Prodika><ConnectionPools>

c. Add the following line:

<config key="ADAPTER_FACTORY" 
value="Class:Xeno.Data.Oracle.OracleDbAdapterFactory,DataLib" 
configAttributeOverrideModifier="CanExtend"></config>

For example:

<ConnectionPools>
  <ProdikaDB configChildKey="key">
    <config key="MAX" value="8" configOverrideModifier="IsLocked"></config>
    <config key="ADAPTER_FACTORY" 
value="Class:Xeno.Data.Oracle.OracleDbAdapterFactory,DataLib" 
configAttributeOverrideModifier="CanExtend"></config>
    <config key="CONNECT_STRING" value="@@VAR:Prodika.DB.URL@@" 
configAttributeOverrideBehavior="Replace" 
configOverrideModifier="IsLocked"></config>
  </ProdikaDB.
</ConnectionPools>
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3. Add the EQT Service config in the EnvironmentSettings and specify the DBHelper 
to be Oracle Specific DB Helper.

a. Open EnvironmentSettings.config.

b. Navigate to the <Services> node under 
<EnvironmentSettings><Core><Prodika>

c. Between the <EmailService> and <SyndicationService> nodes, add 
the following <EQTService> node:

<Prodika>
<Services>
.
.
.
<EmailService configChildKey="name">

<envvar name="EMAIL_DOMAIN_FILTER" value="<YOUR EMAIL DOMAIN - ex: 
oracle.com" configOverrideModifier="IsLocked"/>
<envvar name="BCC_AUDIT_EMAIL_ADDRESS" value="" 
configOverrideModifier="IsLocked"/>
<envvar name="SMTP_SERVER" value="<YOUR SMTP ADDRESS>" 
configAttributeOverrideBehavior="Replace" 
configOverrideModifier="IsLocked"/>

</EmailService>
<EQTService configChildKey="name">

<envvar name="DBHelper"
value="Xeno.Prodika.EQT.Execution.OracleDBHelper,EQT" />

</EQTService>
<SyndicationService configChildKey="name">     

<envvar name="ErrorNotifyFromAddress" value="#CUSTOMER_
FROM@CUSTOMER.COM" configElementOverrideModifier="IsLocked" 
configAttributeOverrideModifier="Replace" />
<envvar name="ErrorNotifyToAddress" value="#CUSTOMER_TO@CUSTOMER.COM" 
configElementOverrideModifier="IsLocked" 
configAttributeOverrideModifier="Replace" />

</SyndicationService> 
.
.
.
</Services>

4. Restart IIS. You can now use the Prodika installation on the Oracle Database. 

Configuring Access to the Database  

Every server, regardless of its location, will need access to the database: 

■ For MSSQL, port 1433 

■ For Oracle DB, port 1521

Installing BI Publisher (Optional)
As an optional step, you can install BI Publisher for Printing and/or Reporting. See 
Appendix E, "Installing BI Publisher" for more information.

Note: Everything in italics is strictly for reference. This should give 
you an idea where in the file the <EQTService> node should be 
placed.
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Completing Optional Steps
For the NPD media bundle, create the WebDAV folder. Some parts of the Agile suite 
use WebDAV to allow in-place editing of certain document types. To allow for this, a 
setting is available in the <PLM4P_HOME>/config/Custom/ 
EnvironmentSettings.config file for the WebDAV virtual folder. In cases for which 
WebDAV is required, create a WebDAV virtual folder and allow the anonymous user 
to access (read and write) the physical folder location on the hard drive. Refer to 
Appendix C, "Installing WebDAV" for instructions.

Determining a Website’s Site ID
To determine the Site ID for a new website within IIS 6.0:

1. Open IIS Manager via Administrative Tools.

2. Expand <server_name> node in the left pane.

3. Highlight the Web Sites node in the left pane.

4. The websites and their corresponding ID will be listed in the right pane.

Post-Installation Checklists
This section discusses tasks that an Agile implementer must complete after installing 
the Agile application suite.

Setting the IIS Event Viewer Logging

If an event log is set to Overwrite events older than 7 days, then you may run into an 
issue when a new feature is introduced that uses multiple Warnings, Errors, or 
Information. The introduction of new event logging can fill up the event log so that no 
more events can be logged, throwing an exception back to the user of the application. 
The exception will not go away until the log is set to Overwrite events as needed or 
until the log is cleared manually. For this reason, we suggest setting all event logs to 
Overwrite events as needed.

To set the IIS Event Viewer Logging in IIS 6.0:

1. On your desktop, right-click the My Computer icon.

2. Click Manage from the fly-out menu to display the Computer Management dialog 
box.

Warning: This step is critical to successfully running the Agile 
application suite. You must set the Event Viewer logging to 
"Overwrite events as needed" for System, Security, Application, and 
all Agile-created event logs. 

Warning: You will need to start up every Agile application, which 
will generate a new event viewer log. Review each event viewer 
setting to make sure the "Overwrite events as needed" option is 
selected.
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3. In the left pane, click System Tools > Event Viewer to display all of the available 
event viewers.

4. Right-click on each event viewer and select Properties to display the Application 
Properties dialog box.

5. Select the Overwrite events as needed option.

6. Click Apply, and then click OK.

Updating the Version Number in the version.txt File
Modify the version.txt file as follows:

1. In your PLM4P_HOME directory, locate the version.txt file. 

2. Open the file with a text editor.

3. Edit the first line so that it contains only the following text:

Version: v6.1.1.0.0

4. Click File > Save to save the change.

Starting the Remote Container Service
To start the remote container service:

1. Right click My Computer.

2. Select Manage from the context menu. The Computer Management console will 
open.

3. Expand the Services and Applications node.

4. Select the Services node.

5. The services will be listed in the main content area.

6. Locate the RemoteContainerService.

7. Right click and select Start.

8. Wait a few seconds to verify that it starts and stays running.

Note: For troubleshooting purposes, if the service starts and then 
stops, check the log file under 

<PLM4P_HOME>\logs\remoteContainer-stdout.log 

to determine the root cause.

Note: For additional troubleshooting ONLY, the remote container 
service can be run from the cmd line as follows: 

<PLM4P_HOME>\remotingcontainer\remotingcontainer 
/normal



Post-Installation Checklists

2-16 Agile Product Lifecycle Management for Process Install/Upgrade Guide



3

Upgrading 3-1

3Upgrading

This chapter discusses upgrading Agile PLM for Process. Topics in this chapter 
include: 

■ Pre-Upgrade Tasks

■ Upgrade Tasks

■ Web Application Tasks

■ Stopping Services and Backing Up Files

■ Installing Software and Scripts

■ Reconfiguring Settings

■ Restarting Remote Container Service and Web Application Server

■ Verifying the Installation

Pre-Upgrade Tasks

Install .Net 3.5 SP1
Prior to installing 6.1.x, you must install .Net 3.5 and the latest available service pack.

Pre Database Upgrade Procedures
If you are upgrading from 6.0.0.x, you will need to perform the following additional 
step.

1. Prior to executing v6.1.0.xml or v6.1.0-orcl.xml using ApplyScripts, you 
must run the pre_v61000_upgrade.sql script.

Note that this file contains sql statements for SQL Server and Oracle. Only execute the 
statements that are for the database you are running. This script identifies the 
following data problems:

■ Verify that there are no 14 digit GLN numbers.

■ Verify there are no cases where non-English doubles are stored as a string on 
elements such as min/max range on breakdowns and alternate packaging units.

Warning: If you do not resolve the problems identified by the 
script prior to upgrading, the database change will result in 
truncation of any GLNs that have more than 13 digits.
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■ Check to see if the new ISO codes being added for core nutrients are the same as 
ISO codes currently being used by the customer. 

Determine Database Executor Role
The database user must have the ability to execute stored procedures on the PLM4P 
database. For an MSSQL database where the user is not dbowner, you may need to 
add a new database role and grant this role to your database user. Consult your 
database administrator for any conflicts.

1. Run the following to create the role

CREATE ROLE db_executor
GRANT EXECUTE TO db_executor

2. Grant this role to your db user (ex. PLM4P_AppUser)

Warning: If you do not resolve the problems identified by the 
script by entering the values using decimals instead of commas 
prior to upgrading, the values entered in the min/max range and 
alternate packaging units will be converted by the system to a 
double and the comma will be ignored. This could cause your data 
to be misrepresented.

For example, 50,5 will be converted to 505 unless it is changed to 
50.5.

Warning: If you do not resolve the problems identified by the 
script by changing the duplicate ISO codes used for UOM’s entered 
in Data Admin in the "Other" category, the system will fail to load.
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Upgrade Tasks
This chapter discusses the basic steps required to upgrade the Agile application suite 
to the 6.1.1 version. The main steps in the upgrade process include:

1. "Checking for Active Web Application Server Sessions" on page A-1

2. "Stop the Web Application Server" on page 3-4

3. "Stop the Remote Container Service" on page 3-4

4. "Back Up the Previous Database Deployment" on page 3-4

5. "Back Up the Previous Oracle Database Deployment" on page 3-5

6. "Install the Agile 6.1.1 Upgrade Software" on page 3-6

7. "Create New Application and Event Logs for PQM and DRLService" on page 3-8

8. "Update the Version Number in the version.txt File" on page 3-8

9. "Apply Database Upgrade Scripts" on page 3-8

10. "Configure the Environment Variables Settings" on page 3-10

11. "Reconfigure the Application Environment Settings" on page 3-11

12. "Reconfigure the Customer Settings" on page 3-11

13. Apply extensions, if any

14. "Restart the Remote Container Service" on page 3-12

15. "Restart the Web Application Server" on page 3-12

16. "Verifying the Installation" on page 3-12
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Web Application Tasks

Stop the Web Application Server
After you have verified that there are no active sessions on the Web application server 
(see Appendix A, "Checking for Active Web Application Server Sessions"), stop the 
web server.

At a command prompt, enter the following:

c:\> iisreset /stop

For performance, you can now run PLM4P as a 64-bit application.  This will give the 
application access to a larger memory address space.

To switch to a 64-bit application, change the application pool setting, Enable 32-bit 
applications from 'True' to 'False'.

If you are upgrading an environment that accesses an Oracle DB, then you will also 
need to install the 64-bit Oracle DB client. Depending on your environment and how 
you have separated your applications, you may also need to increase your physical 
server memory.

Stopping Services and Backing Up Files

Stop the Remote Container Service
Using IIS Computer Management, stop the remote container service as follows:

1. Right-click My Computer and select Manage from the shortcut menu to display 
the Computer Management dialog box.

2. Under Services and Applications, select Service to display a list of services in the 
right pane.

3. Locate the RemoteContainer Service and click it.

4. Select the Stop the Service option in the top left-hand portion of the Services pane.

Back Up the Previous Database Deployment
Using SQL Server Enterprise Manager, back up the previous deployment of the 
database. Be sure to use a meaningful name for the backup for future reference; for 
example, Agile 6.1.0.1 - Full Backup.

1. Open SQL Server Management Studio.

2. In the left pane under Databases, locate the database instance to back up.

3. Right-click the database and select Tasks > Back Up... from the shortcut menu.

4. Select the destination for your backup. Select the Add... button to the right of the 
Back up to: text area. A dialog box will appear in which you can choose where to 
store the backup file. After you have chosen a name, click the OK button.

Note: The database server must be running in order to perform the 
backup.
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5. Click the OK button at the bottom of the dialog and the backup process will begin.

Back Up the Previous Oracle Database Deployment
Recovery Manager (RMAN) is the recommended method of backing up your Oracle 
database and may be accessed via Enterprise Manager. 

1. Open Enterprise Manager. 

2. Configure backup settings.

a. Select Enterprise Manager > Availability > Backup Settings. 

b. Set the disk backup location and backup type. Be sure to use a meaningful 
name for the backup for future reference.

3. Schedule the backup.  

a. Select Enterprise Manager > Availability > Schedule Backup.  

b. Select either the Oracle-Suggested Backup strategy or your own customized 
strategy. The Oracle-Suggested Backup strategy makes a one-time 
whole-database backup. To use the Oracle strategy, for backup type, select Full 
Backup. For Schedule, select One Time (Immediately).

4. Review and submit the backup. The Review screen allows you to review your 
selections and submit the job. 

Note: It is recommended that you create a full backup of the whole 
database.
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Installing Software and Scripts

Install the Agile 6.1.1 Upgrade Software
The upgrade process is a manual process that uses batch files. The number of steps 
during the upgrade process is determined by the applications that you utilize within 
your installation.

For each installation, you will need to install the Core package first. This package 
needs to be installed only once per server instance.

After installing the Core package, depending on your installation, you will install one 
to four media packs. Each media pack is installed in the same manner outlined below.

Set Up the Installation Environment

Download the Media Pack installation file for the specific media pack being installed. 
Unzip the media pack zip archive to a temporary directory (i.e.; c:\INSTALL_HOME). 
Follow the directions detailed below for Core/Media Pack installation.

Upgrade the Software

Archiving the Previous Installation  

The first step in the upgrade process is to manually archive the previous installation, 
as described below. This step is very important.  As with any major or minor release, 
you cannot overlay 6.1.1 on top of your existing installation or you will encounter 
errors related to missing or incorrect DLL files.  

1. Move (i.e. cut) all of the directories other than attachments/XDocuments and logs 
directories to your designated archive location. It is recommended that you name 
the containing directory as the version that you are upgrading from (i.e.  v6.1.1 - 
installation, etc.).

Installing the Core Bundle  

2. The next step in the upgrade process is installing the Core bundle. 

Note: This step is common to all media pack installations.

Note: For example, in 6.1.1, all DLLs were removed from the root of 
the RemotingContainer directory.  If an overlay is performed, an error 
will be encountered when attempting to start the RemotingContainer.

Note: This should be done only once per PLM4P_HOME, meaning that 
if you have multiple installations of the Prodika suite of applications 
running on the same server, you will need to perform this step only 
once per Prodika installation.
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Throughout the instructions below, the place where you extracted the media bundle 
zip file will be referred to as INSTALLER_HOME.

3. Open the containing directory for INSTALLER_HOME.

4. Extract Core.zip located in INSTALLER_HOME to a temporary directory (i.e.  
c:\temp). This will give you a directory structure like c:\temp\Apps, 
c:\temp\Config, etc. - this temporary directory will be referred to as TEMP_HOME.

5. Copy FileCompressionHelper.exe from INSTALLER_HOME to TEMP_HOME.

6. Open a command prompt and navigate to TEMP_HOME (i.e.  >cd c:\temp)

7. Run the following (it is extremely important that you perform this decompression 
before moving on to install any additional media pack bundle files):

FileCompressionHelper.exe -d

8. When the distribution is complete, move the contents of TEMP_HOME to PLM4P_
HOME.

Upgrade the Media Pack Applications
For each media bundle you will follow the same nine step process below. The one 
exception is with the NPD media bundle installation. With NPD, there is no need to 
perform step 6.

1. If there are any files remaining in your TEMP_HOME, remove them.

2. Unzip the media pack zip file located in your INSTALLER_HOME directly to TEMP_
HOME.

3. Confirm media bundle names for the ZIP files, where the name can be one of :

■ MP1.zip for the PDM install

■ MP2.zip for the FC install

■ MP3.zip for the PSC install

■ MP4.zip for the NPD install 

■ MP5.zip for the PQM install

4. Copy FileCompressionHelper.exe from INSTALLER_HOME to TEMP_HOME.

5. Open a command prompt and navigate to TEMP_HOME (i.e.; >cd c:\Temp).

6. Run the following (it is extremely important that you perform this decompression 
before moving on to install any additional media pack bundle files):

FileCompressionHelper.exe -d

7. When the distribution is complete, move the contents of TEMP_HOME to PLM4P_
HOME.

8. You will receive a warning that a Web and config directory already exist; accept 
this to move the contents into these directories.

9. Accept the warning to overwrite the configuration file PLM4P_
HOME\Config\Core\FeatureDeployment\<media 
pack>-FeatureConfig.config.
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Create New Application and Event Logs for PQM and DRLService
For increased security, we separated the DRL application from the DRL service. This  
requires installing the new DRLService IIS application.

1. To create the application and associated virtual directories, from a command 
prompt, run:

INSTALLER_HOME\Installer\Tools\SetupCoreVirtualDirectories.bat <PLM4P_HOME> 
<siteid> <AppPool>  

If you purchased and are configuring PQM, you must create the IIS application and 
add the event log.

1. To create the IIS application and associated virtual directories, from a command 
prompt, run: 

INSTALLER_HOME\Installer\Tools\SetupPQMVirtualDirectories.bat  <PLM4P_HOME> 
<siteid> <AppPool>

2. To create the event log, from a command prompt, run: 

INSTALLER_HOME\Installer\Tools\EventLogs\PQM-Prodika.reg

Update the Version Number in the version.txt File
Modify the version.txt file as follows:

1. In your PLM4P_HOME directory, locate the version.txt file. 

2. Open the file with a text editor.

3. Change the first line so that it contains only the following text:

Version: v6.1.1

4. Click File > Save to save the change.

Apply Database Upgrade Scripts
It is MANDATORY to run the PKID Migration utility for MSSQL or Oracle DB. PKID 
Migration for MSSQL was introduced in 6.1.0. PKID Migration for Oracle DB was 
introduced in 6.1.1.  Please find instructions for both in this section, below.

Applying PKID Migration for Microsoft SQL Server
This applies to MSSQL customers, only. If you are running Oracle DB or you have 
already upgraded to 6.1.0, skip this step. 

It is mandatory to run the MSSQL PKID Migration utility as found in Extensibility 
Pack 2.7. Refer to the Extensibility Pack for instructions on how to complete this 

Warning: It is very important that you back up the database as 
indicated in "Back Up the Previous Database Deployment" on 
page 3-4 before upgrading the database. Once the scripts have been 
applied, there is no way to revert the database to the previous state 
without a backup.

Note: If you are upgrading from 6.0.0.3 or prior, you must first install 
6.0.0.3.36.
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upgrade task. Once executed, you will see an improvement to overall performance of 
the application.

Apply 6.1.0 Database Upgrade Script
To run the database upgrade script:

1. Open a command prompt and navigate to the directory where you unzipped the 
upgrade package.

2. Change directories (cd) to the Installer/ApplyScripts directory.

3. Run the following:

■ If upgrading Microsoft SQL Server

ApplyScripts -c "server=; uid=; password=; database=" -f v6.1.0.xml

■ If upgrading Oracle DB Server

ApplyScripts -c "user id =; password=; data source=" -dbvendor orcl -pre 
ora_cert_fi.p1.sql ora_cert_fi.p2.sql ora_cert_fi.p3.sql -f v6.1.0-orcl.xml

4. Confirm that the database upgrade script was applied successfully when the 
system prompts you with the following message:

"Complete - with no errors"

Applying PKID Migration for Oracle DB Server
This applies to Oracle DB customers, only. If you are running Microsoft SQL Server, 
skip this step.

Running Oracle PKID Migration utility found in Core.zip of each Media Pack is 
required. Failure to run Oracle PKID Migration utility may result in undesired 
behavior.

To apply PKID migration:

1. Back up the database.

2. Locate the OraclePKIDMigration tool under 
ProdikaHome\Apps\OraclePKIDMigration.

3. Verify configurations in OraclePKIDMigration.exe.config for the database 
connection string and home directory.   

■ <add key="Oracle.ConnectString" value="User 
Id=;Password=;Data Source=;" />

■ <add key="OraclePKIDMigration.Home" 
value="C:\Prodika\Apps\OraclePKIDMigration\" />

4. Open command prompt to directory with OraclePKIDMigration.exe

5. Execute OraclePKIDMigration /testConnection to verify connectivity to 
the database.

6. Execute OraclePKIDMigration /install

This step creates the migration packages and required objects on the database.

7. Make sure you have a database backup before proceeding.

8. Execute OraclePKIDMigration /convert

This may take awhile depending on the size of the database.
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Logs  

■ The table, PKID_REMAP_LOG, contains logging information from the process

■ The table, PKID_REMAP_CLEANUP, contains statistics on bad references found 
during the conversion.

■ The mapping tables, archive tables and original tables will all remain in the 
database so that data can be verified.  It is recommended to keep these tables until 
all data is verified.  

9. Drop the conversion tables by executing,  OraclePKIDMigration 
/dropAllConversionTables

Apply 6.1.1 Database Upgrade Script
To run the database upgrade script:

1. Open a command prompt and navigate to the directory where you unzipped the  
upgrade package.

2. Change directories (cd) to the Installer/ApplyScripts directory.

3. Apply the scripts using the following call to the ApplyScripts.exe utility:

a. If running the SQL Server database upgrade:

ApplyScripts -c "server=; uid=; password=; database=" -f 
v6.1.1.xml

b. If running the Oracle database upgrade:

ApplyScripts -c "user id =; password=; data source=" 
-dbvendor orcl -f v6.1.1-orcl.xml

4. Confirm that the database upgrade script has been applied successfully when the 
system prompts you with the following message:

"Complete - with no errors" 

Applying Language Packs 
For instructions on installing language packs, see "Installing National Language 
Support" on page D-1. 

Applying BI Publisher
For instructions on installing BI Publisher, see "Installing BI Publisher" on page E-1. 

Reconfiguring Settings

Configure the Environment Variables Settings
Using a text-based editor, open the environmentvariables.config file and 
update the server names and port addresses.

Reconfigure the Username and Password Settings
With the 6.1 release, the DRL web service username and password settings have been 
removed from environmentvariables.config and must now be configured 
using the Setup Assistant tool. The default username value in the Setup Assistant is 
prodikaadmin so be sure to update this username and password setting to your previous 
DRL user settings. The DRL user must be a valid, active PLM for Process user.
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The SQL Server Reporting Services (SSRS) and the BI Publisher username and 
password settings have also been removed from environmentvariables.config 
and added to the Setup Assistant tool. If you are using SSRS and/or BI Publisher for 
Printing and/or Reporting, you must enter these settings into the SetupAssistant tool. 
These user settings are not Agile PLM for Process users—rather, they are users created 
through SSRS and BI Publisher.

Reconfigure the Application Environment Settings
Using a third party diff tool, you will need to reconfigure the 
environmentSettings.config file located in your PLM4P_HOME\Config\ 
directory.

To reconfigure application environment settings:

1. Rename the new environmentSettings.config file; change the name to 
environmentSettings.config-new.

2. Make a backup copy of the archived version of the 
environmentSettings.config file (from the archived directory) and copy it 
into the PLM4P_HOME\Config\Custom\ directory.

3. Using the diff tool, compare the environmentSettings.config-new file to 
the archived copy of the environmentSettings.config file.

4. When you have completed the file comparison and updates, delete the copy that 
you made of the archived environmentSettings.config file.

5. Rename the environmentSettings.config-new file; change the name back to 
environmentSettings.config.

Reconfigure the Customer Settings
Using a diff tool such as WinMerge, you will need to reconfigure the 
CustomerSettings.config file located in your PLM4P_HOME\Custom\ directory.

To reconfigure customer settings:

1. Rename the new CustomerSettings.config file; change the name to 
CustomerSettings.config-new.

2. Make a backup copy of the archived version of the CustomerSettings.config 
file (from the archived directory) and copy it into the PLM4P_
HOME\Config\Custom\ directory.

3. Using the diff tool, compare the CustomerSettings.config-new file to the 
archived copy of the CustomerSettings.config file.

4. Carefully merge any configuration differences for your particular customer needs.

5. When you have completed the file comparison and updates, delete the copy that 
you made of the archived CustomerSettings.config file.

6. Rename the CustomerSettings.config-new file back to 
CustomerSettings.config.

Note: For further guidance, refer to the “Environment Variable 
Settings” section of the Agile Product Lifecycle Management for Process 
Configuration Guide.
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Reconfigure the DRL Web Service Username and Password Settings
With the 6.1 release, the DRL web service settings have been removed from 
environmentvariables.config and must now be configured using the Setup 
Assistant tool.

Restarting Remote Container Service and Web Application Server

Restart the Remote Container Service
Using IIS Computer Management, restart the remote container service:

1. Right-click My Computer and select Manage from the shortcut menu to display 
the Computer Management dialog box.

2. Under Services and Applications, select Service to display a list of services in the 
right pane.

3. Locate the RemoteContainer Service and click it.

4. Select the Start the Service option in the top left portion of the Services pane. 

Restart the Web Application Server
Using a command prompt, restart the IIS Web application server:

1. Open a command prompt.

2. Enter the following command:

C:\iisreset

The Web application server restarts.

Verifying the Installation
Log in to the Agile user portal and verify that the installation is functioning 
correctly. We recommend that you perform a variety of post-installation tests to 
ensure that all the applications are functioning correctly. For more information, see 
Appendix B, "Verification Tests".
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4Working with Multiple Servers

This chapter provides guidance for working with multiple servers. Topics in this 
chapter include:

■ Architecture Environment Strategy

■ Topology Example of Production Environment

■ Multiple Server Configuration

Architecture Environment Strategy
A good environment strategy supports the following project/business needs:

■ Support the application upgrade process.

■ Provide a structured process for migration (development, test, user acceptance) of 
bug fixes, new features, functionality, and configurations.  Specifically focusing on 
allowing reasonable access to environments during migration.

■ Provide a means for preparing/staging data for transfer into a production 
environment.

Figure 4–1 shows a sample environment.
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Figure 4–1 Sample architecture

Verifying Environment Strategy
Use the following questions to help verify your environment strategy:

■ What is the path for upgrading the application from version x to version y?

■ What is the process for testing production issues?  Which environments will be 
available for testing: Development, QA/UAT, and/or Production?

■ Where will end users be trained on the application?

■ Where will extensible solutions be developed?

■ Where will hot fixes be initially applied?  What is the path for migrating hot fixes 
to production?

■ Where will data loading be tested/verified?

■ How will multiple tasks be supported?

Also consider the following:

■ Migrating from version x to version y and configuring the application to support 
new functionality.

■ Testing new functionality and supporting production configurations and hot fixes. 

■ If the implementation is split into multiple projects, how will different project 
teams share environments?

Development
The development environment typically is used as a place to: 

■ Deploy new releases (first place)

■ Develop extensible solutions 

■ Use for initial test and troubleshooting
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■ Use for prototyping and discovery

■ Make configuration changes, which are then applied in QA

Quality Assurance/User Acceptance Testing
The Quality Assurance (QA)/User Acceptance Testing (UAT) environment typically is 
deployed to closely match the Production environment, and is used as a place to:

■ Include load balancers, etc.

■ Formally test configuration changes

■ Perform periodic refreshes from the Production environment

■ Consider data security/access

■ Perform training tasks

Production/Export
The Production/Export environment typically is used as a place to:

■ Perform data/user/workflow administrative tasks

■ Act as the data staging/acceptance environment

■ Complete administrative data changes , then export the changes to other 
environments

Production/Import
The Production/Import environment typically is used as a place where:

■ The user community interacts with data on a day to day basis.

■ Administrative data changes are pushed from the export environment to the 
import environment

■ Configuration changes are pushed from QA

Export/Import
If an environment has applications servers to support the export and import structure, 
then note the following:

The general business process:

■ Admin creates records via the export application.

■ Admin exports records via the export application.

■ Admin imports record via the import application. 

Applications that support the export/import process:

■ User Group Manager (UGM)—Users and groups are exported and imported

■ Workflow  Administration (WFA)—Workflows are exported and imported

■ Data Admin (ADMN)—Allergens, additives, extended attributes, and other 
administrative data are exported and imported

Note: The Production/Export environment must be on same version 
as import environments.
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When managing the Export/Import structure the databases must be kept 
synchronized. If changes are made directly in the import application environment, and 
the exact changes (including primary keys) are not applied to the export environment 
as well, the Export/Import relationship is broken. 

To reestablish the Export/Import relationship the following steps must be performed:

1. Copy or backup the import database.

2. Restore the import database to the export database.

The relationship is now restored. Make changes to data via the export application and 
import via the import application.

Imports and Exports are only possible if both environments use the same version.

Example 1—Export v6.1.1 can push to Import v6.1.1

Example 2—Export v6.1.1 cannot push to Import v6.1.0

These examples demonstrate that users, workflows and administrative data cannot be 
updated or moved when application versions are different.
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Topology Example of Production Environment
Figure 4–2 depicts the hardware/software topology options for a production 
environment.

Figure 4–2 Topology example, Production environment

Topology Example A
Example A, shown in Figure 4–3, highlights:

■ Database clustering

■ Load balancing

■ Separate and centralized file server
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Figure 4–3 Topology Example A

Topology Example B
Topology B example, shown in Figure 4–4, highlights: 

■ Standard database

■ Logically distributed applications

■ Centralized file server shared with application server
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Figure 4–4 Topology example B
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Multiple Server Configuration
Following are the settings for configuring an environment with multiple servers 
running different application modules. Currently, two scenarios are provided.  This 
includes one for multiple servers with NO reverse proxy, and one for multiple servers 
with a reverse proxy.

Files Modified
%PLM4P_HOME%\Config\EnvironmentVariables.config

%PLM4P_HOME%\Config\Custom\EnvironmentSettings.config

Recommended Configuration
Customer has chosen to use a reverse proxy or hardware load balancer. Application 
URLs should be configured in EnvironmentVariables.config as Client-Server, 
meaning it is the URL the client will see and use in Internet Explorer. Web Service 
URLs should be configured in EnvironmentVariables.config as Server-Server, 
meaning the web service call will NOT be passed to the client.

SSL Configuration (Optional)
A single SSL certificate will need to be purchased and installed on the reverse proxy or 
load balancer, corresponding to the main application URL.

App Configuration
The following is an example, only. There are additional application URLs that are not 
listed below.

1. Open the %PLM4P_HOME%\Config\EnvironmentVariables.config file:

# Server Topology Information

Prodika.Server1.URL = https://plm.xenodev.com

Prodika.Server2.URL=http://plmapp1.xenodev.com

Prodika.SCHEME =https

# Application URL Information

Prodika.GSM.URL=@@VAR:Prodika.Server1.URL@@/gsm

Prodika.GSMInterApp.URL=@@VAR:Prodika.Server2.URL@@/gsm

Prodika.SCRM.URL=@@VAR:Prodika.Server1.URL@@/scrm

Table 4–1 Recommended Scenario 

Server Name Friendly URL App Modules

RPServer001 plm.xenodev.com N/A

AppServer001 plmapp1.xenodev.com GSM, SCRM, Portal

AppServer002 plmapp2.xenodev.com NPD, DRL

AppServer003 plmapp3.xenodev.com WFA, UGM

Note: The main application URL is https://plm.xenodev.com.
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Prodika.NPD.URL=@@VAR:Prodika.Server1.URL@@/npd

Prodika.Portal.URL=@@VAR:Prodika.Server1.URL@@/portal

# DRL Attachment is used for file upload by the WebApp and 
WebService

Prodika.DRLService.URL=@@VAR:Prodika.Server2.URL@@/drl

Prodika.DRLAttachment.URL=@@VAR:Prodika.Server1.URL@@/drl 

Prodika.DRL.URL=@@VAR:Prodika.Server1.URL@@/drl

Prodika.WFA.URL=@@VAR:Prodika.Server1.URL@@/wfa

Prodika.UGM.URL=@@VAR:Prodika.Server1.URL@@/ugm

Result
The application suite is separated on multiple servers. GSM and Portal run on 
AppServer001, NPD runs on AppServer002, etc. No matter what application is 
opened, the user will always see https://plm.xenodev.com/<module> as the URL in 
the browser. Web Service calls, as such for GSMInterApp and DRL, will be passed 
internally, from server to server.

Optional Configuration
In some cases, a customer does not have or has chosen not to use a reverse proxy or a 
hardware load balancer.  Application URLs should be configured in 
EnvironmentVariables.config as Client-Server, meaning it is the URL the client 
will see and use in Internet Explorer.  Web Service URLs should be configured in 
EnvironmentVariables.config as Server-Server, meaning the web service call 
will NOT be passed to the client.

SSL Configuration (Strongly Recommended for Production Environments)  

An SSL certificate will need to be purchased and installed on each application server, 
corresponding to the friendly URL provided.

App Configuration  

The following is an example, only. There are additional application URLs that are not 
listed below.

1. Open the %PLM4P_HOME%\Config\EnvironmentVariables.config file:

# Server Topology Information

Prodika.Server1.URL = https://plm.xenodev.com

Prodika.Server2.URL=https://plmapp2.xenodev.com

Table 4–2 Optional Scenario

Server Name Friendly URL App Modules

AppServer001 plm.xenodev.com GSM, SCRM, Portal

AppServer002 plmapp2.xenodev.com NPD, DRL

AppServer003 plmapp3.xenodev.com WFA, UGM

Note: The main application URL is https://plm.xenodev.com.
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Prodika.Server3.URL=https://plmapp3.xenodev.com

Prodika.SCHEME =https

# Application URL Information

Prodika.GSM.URL=@@VAR:Prodika.Server1.URL@@/gsm

Prodika.GSMInterApp.URL=@@VAR:Prodika.Server1.URL@@/gsm

Prodika.SCRM.URL=@@VAR:Prodika.Server1.URL@@/scrm

Prodika.NPD.URL=@@VAR:Prodika.Server2.URL@@/npd

Prodika.Portal.URL=@@VAR:Prodika.Server1.URL@@/portal

# DRL Attachment is used for file upload by the WebApp and 
WebService

Prodika.DRLService.URL=@@VAR:Prodika.Server2.URL@@/drl (see 
note)

Prodika.DRLAttachment.URL=@@VAR:Prodika.Server2.URL@@/drl 

Prodika.DRL.URL=@@VAR:Prodika.Server2.URL@@/drl

Prodika.WFA.URL=@@VAR:Prodika.Server3.URL@@/wfa

Prodika.UGM.URL=@@VAR:Prodika.Server3.URL@@/ugm

Result
The application suite is separated on multiple servers. GSM and Portal run on 
AppServer001, NPD runs on AppServer002, etc. The user will see the corresponding 
URL based on the application that is opened. For example, when the user opens GSM, 
the user will see https://plm.xenodev.com/GSM as the URL in the browser. 
Subsequently, when the user opens NPD, the user will see 
https://plmapp2.xenodev.com/NPD as the URL in the browser. 



A

Checking for Active Web Application Server Sessions A-1

AChecking for Active Web Application Server
Sessions

This appendix describes the two checks that you should perform to make sure there 
are no active user sessions on the server. 

Check the Performance System Monitor for Active Sessions
Using Performance System Monitor, check to see how many people currently have 
active sessions.

1. Select Start > Run.

2. In the Run dialog box, type perfmon and click OK to bring up the Performance 
dialog box.

3. Select the System Monitor option in the left pane to bring up the System Monitor 
dialog box.

4. In the bottom portion of the System Monitor dialog box, a list of counters is 
displayed. Right-click in this area and select Add Counters from the shortcut 
menu to display the Add Counters dialog box.

5. Select the Select Counters from Computer option and select your Web application 
server.

6. From the Performance Object drop-down list, select ASP.NET Apps v2.0.50727. 

7. Select the Select Counters From List option and from the associated scrolling list, 
choose Sessions Active, and then click Add.

8. Click Close to close the Add Counters dialog box.

9. Using the new active sessions counter, you can view the active sessions for the 
Web application server by selecting its row in the counter list at the bottom of the 
System Monitor dialog box. In particular, look at the number of active sessions in 
the Last field. If this number is greater than 2 active sessions, it is likely that users 
are logged on to the server. Contact the user(s) to have them log off before you 
shut down the Web application server.

Note: We recommend that you notify all users in advance that you 
are performing the upgrade, to give them time to shut down their 
connections.
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10. You can save the active sessions counter by right-clicking it and selecting Save As 
from the shortcut menu. You may wish to save this counter to your desktop for 
future use.

Check the Event Viewer for Last Login
Using IIS Computer Management, check the Event Viewer log for Agile to see when 
the last user login occurred.

1. Right-click My Computer and select Manage from the shortcut menu to display 
the Computer Management dialog box.

2. Under System Tools, select Event Viewer.

3. Locate and double-click the Portal-Prodika log under Event Viewer.

4. Review the log to see when the last user login occurred. If a recent login has 
occurred, it is likely that a user is still logged on to the server. Contact the user to 
have them log off before you shut down the Web application server.
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BVerification Tests

Verification Tests
Perform the following verification tests after installation or upgrade. 

■ Global Specification Management Test

■ Printing Test

■ Attachment Test

■ Reporting Test

■ Supply Chain Relationship Management Test

■ Nutrition Surveillance Management Test

■ eQuestionnaire Test

■ New Product Development Test

■ Product Quality Scorecard Test

■ Component Catalog Test

■ Computer Aided Compliance Screening Test

■ Supplier Portal Test

■ User Group Administration Test

■ Workflow Administration Test

■ Product Quality Management Test

■ Manage Core Data Test

■ Manage Data Caches Test

Login Information
In order to perform the recommended verification tests, you will need the user name 
and password for the user account having access to all applications. The standard 
username and password that ships with the certified database is:

Username: prodikaadmin

Password: agile

Warning: After first login, you will be prompted to assign a new 
password. 
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User access is managed using the User Group Management (UGM) application. For 
more information on user management, see the Agile Product Lifecycle Management for 
Process Administrator User Guide.

To verify installation:

1. Turn on Agile PLM for Process.

2. Access the Agile application using Internet Explorer. Use the following Fully 
Qualified Domain Name (FQDN) URL:

https://server.domain.tld/portal

3. Type your use name and password, and press the Enter key. You will be prompted 
to change your password. 

4. Type a new password in the Password field, and again in the Repeat Password 
field, and press the Enter key. 

Global Specification Management Test
Before performing this test, note that specifications, once created, cannot be deleted 
from GSM. Therefore, creating specifications for verification purposes contributes to 
the proliferation of meaningless specifications. If specifications already exist in the 
system, you may wish to skip this test.

The purpose of this test is to verify that GSM is properly functioning. 

To perform the GSM test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select GSM > Material Specifications.

3. Click Create New. A new material specification is displayed.

4. Type a specification name in the Spec Name field.

5. Complete the Approved for Use In section at the bottom of the page.

6. Click Save & Close.

7. From the left navigation panel, select GSM > Material Specifications.

Warning: Be sure to use a fully qualified domain name rather than 
just a servername. Example: https://app.prodika.com/portal 
vs. https://app/portal.

Note: The following installation verification tests assume that you 
have installed the entire Agile application suite. If this is not the case, 
omit tests for applications that you have not installed.

Warning: You must be assigned the correct Agile roles to perform 
these installation verification tests. For more information on roles, 
see the Agile Product Lifecycle Management for Process 
Administrator User Guide.
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8. Conduct a blind search by clicking Reset and then Search or specify search criteria 
to retrieve the specification that you just created.

9. In the Search Results table, click the row containing the specification you created. 
The selected specification is displayed.

10. Click Workflow.

11. Type any value in the Comments field.

12. Click the move step forward icon ( ). If additional dialog boxes appear, it 
confirms that GSM is functioning.

Printing Test
The purpose of this test is to verify that the Agile Printing Service is correctly 
functioning. 

To perform the Printing test:

1. Log in to Agile Product Lifecycle Management for Process.

2. From the left navigation panel, select GSM > Material Specifications.

3. Search for the specification that you created in "Global Specification Management 
Test" on page B-2.

4. Click Print in the action menu.

5. In the resulting Print dialog box under Current Specification > Sections, select any 
check box.

6. Click Print again. The specification is rendered in PDF format in a separate 
window.

7. Close the window once the PDF is successfully displayed and proceed to the next 
test.

Attachment Test
The purpose of this test is to verify that the Attachments feature is correctly 
functioning.

To perform the Attachment test:

1. Navigate to any trade specification in GSM.

2. Select the Supporting Documents tab.

3. Click Edit to put the specification in edit mode.

4. Select the Attachments/Procedures link under Supporting Documents.

5. Click Add New button.

6. In the Title field, type test.

7. Click the Browse… button, select a file, and then select Open.

Note: To remove the test data in a production environment, restore 
your database, restart the Remoting Container, and then restart the 
application pools. This returns the environment to the default 
installation state. 
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8. Click the Upload button. The first upload may take up to 30 seconds to complete.

9. Click Done in the Attachment Detail window.

10. Click Done in the Attachment/Procedures window.

Reporting Test
The purpose of this test is to verify that the Prodika Reporting Service is correctly 
functioning. 

To perform the Reporting test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, click RPT (Reporting).

3. Search for the specification that you created in "Global Specification Management 
Test" on page B-2.

4. Click Generate Report.

5. In the resulting dialog, type a report name in the Report Name field and then click 
Save.

6. In the left navigation panel, select Ad Hoc Reports > Reports Queue.

7. The resulting Reports Queue should contain an entry for your report. Refresh this 
view periodically by toggling from Reports Queue to Reporting and back, to see 
the status of your report update. If the report status fails to update, there is likely a 
problem with the Reporting Service.

8. When the report status indicates Complete, click the hyperlinked name of the 
report to download the report.

Supply Chain Relationship Management Test
The purpose of this test is to verify that the SCRM application is correctly functioning. 

To perform the SCRM test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select SCRM > Company Profiles.

3. Conduct a blind search and select any company profile from the Search Results 
table to verify that it is displayed correctly.

4. If the company profile is displayed, click Cancel and proceed to the next test.

Nutrition Surveillance Management Test
The purpose of this test is to verify that the NSM application is correctly functioning. 

To perform the NSM test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select NSM > Nutrient Analysis.

3. Click Create New.

Note: The size of the selected file must be less than the designated 
limit.
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4. If the Nutrient Analysis template is displayed, click Cancel and proceed to the 
next test.

eQuestionnaire Test
The purpose of this test is to verify the eQ application is correctly functioning. 

To perform the eQ test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select eQ > Material Questionnaires.

3. Click Create New.

4. If the eQuestionnaire page is displayed, click Cancel and proceed to the next test.

New Product Development Test
The purpose of this test is to verify that the NPD application is correctly functioning. 

To perform the NPD test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select NPD > New Product Development > 
Projects.

3. Conduct a blind search and select any project from the Search Results table to 
verify that it is displayed correctly. If so, NPD has passed the test.

4. If no projects are found, click Create New.

5. Select a business unit and project type in the resulting dialog box and then click 
Done.

6. If the NPD (Stage 1) template is displayed, click Cancel and proceed to the next 
test.

Product Quality Scorecard Test
The purpose of this test is to verify that the PQS application is correctly functioning. 

To perform the PQS test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select PQS > Lot Samples.

3. Click Create New. The Lot Sample page loads.

4. In the Code Data or Sample ID field, type any text. 

5. Click Next. The Select Specification page loads.

6. In the Specification section, click the search icon ( ) next to the Specification 
field. A Specification Search dialog box appears.

7. In the resulting Search dialog box, type criteria to find and select the material 
specification that you created in "Global Specification Management Test" on 
page B-2.

8. If the material specification is displayed, the test has succeeded. 

9. Click Close, and proceed to the next test.
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Component Catalog Test
The purpose of this test is to verify that the Component Catalog service is correctly 
functioning. 

To perform the Component Catalog test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select GSM > Component Catalog.

3. Conduct a blind search and select any catalog term from the Search Results table.

4. If the catalog term is displayed successfully, click Cancel and proceed to the next 
test.

5. If no catalog terms are found, click Create New.

6. Type a name for the catalog term in the Component Catalog field.

7. Click Save & Close.

Computer Aided Compliance Screening Test
The purpose of this test is to verify that the CACS application is correctly functioning. 

To perform the CACS test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select CACS.

3. Conduct a blind search and select any computer aided compliance screen from the 
Search Results table to verify that it is displayed correctly.

4. If no computer aided compliance screens are found, click Create New.

5. Type a name for the screen in the Title field and a description in the Description 
field.

6. Click Save & Close.

Supplier Portal Test
The purpose of this test is to verify that the Supplier Portal application is correctly 
functioning. First, log in to Supplier Portal and create a new registrant request:

To register with Supplier Portal:

1. Access Supplier Portal at https://server.domain.tld/supplierportal. 

2. Select a Language, and on the login page click click HERE if you have not 
registered with this site. 

3. Follow the screens, filling out all required data. Once you are done, click Submit. 
You have now submitted a registration request. Make note of your User Name and 
Password. 

To perform the SPA test:

1. Log in to Agile PLM for Process as a Supplier Portal administrator.

2. From the left navigation panel, select SPA > New Registrations.

3. The registration request you just submitted should be displayed.
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User Group Administration Test
The purpose of this test is to verify that the UGM application is correctly functioning. 

To perform the UGM test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select UGM > Groups.

3. Conduct a blind search and select any group from the Search Results table to 
verify that it is displayed correctly.

Workflow Administration Test
The purpose of this test is to make sure that the WFA application is correctly 
functioning. 

To perform the WFA test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, click WFA (Workflow Administration).

3. Click Create New.

4. If the process template is displayed successfully, click Cancel and proceed to the 
next test.

Product Quality Management Test
The purpose of this test is to make sure that the PQM application is correctly 
functioning. 

To perform the PQM test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, select PQM > Issues.

3. Conduct a blind search and select any issue from the Search Results table to verify 
that it is displayed correctly. If so, PQM has passed the test.

4. If no issues are found, click Create New.

5. Enter a title, and select a type and workflow on the Issue page, and then click Save 
& Close.

Manage Core Data Test
The purpose of this test is to verify that the ADMN (Manage Core Data) application is 
correctly functioning. 

To perform the ADMN test:

1. Log in to Agile PLM for Process.

Note: You need to be a supplier portal administrator to log in to SPA. 
Refer to the Agile PLM for Process Extensibility Pack documentation 
to find out how to create a supplier portal administrator user. You can 
find this documentation in the Agile Product Lifecycle Management for 
Process Data Administration Toolkit Guide.
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2. From the left navigation panel, select ADMN > GSM Compliance > Additives.

3. If the additives currently in the system are displayed successfully, click Cancel and 
proceed to the next test.

Manage Data Caches Test
The purpose of this test is to verify that the CACHE application is correctly 
functioning. 

To perform the CACHE test:

1. Log in to Agile PLM for Process.

2. From the left navigation panel, click CACHE (Manage Data Caches).

3. If the Schedule Cache Flush page is displayed successfully, the test has succeeded.

You can now use the scheduled Cache Flush Queue feature to see details for the 
different applications that been flushed. For more information, refer to the “Using 
CACHE to Manage Caches” chapter of the Agile Product Lifecycle Management for Process 
Administrator User Guide.
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CInstalling WebDAV

This appendix contains instructions for installing and configuring WebDAV.

Enabling WebDAV
To make sure that Web Sharing is enabled in IIS:

1. Open the IIS Manager, and then select Web Service Extensions. 

2. Enable WebDAV if it is not already set to “Allowed,” as Figure C–1 shows below:

Figure C–1 Enabling WebDAV

Warning: If you are installing the main application on IIS7.x, then 
you must have a separate web server with IIS6 or Apache 2.2 
installed for WebDAV.
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Creating the Directory Structure
To configure WebDAV:

1. Create the directory structure as follows:

WebDAV\
WebDAV\PDFComments
WebDAV\NPDWorkArea

Figure C–2 Directory Structure

Sharing the WebDAV Directory
To share the WebDAV directory:

1. Right click on the WebDAV Directory and select Properties.

2. Select the Web Sharing tab.

3. Share the folder as WebDAV.

4. Click Edit Properties.

5. Check Read, Write and allow Scripts, as Figure C–3 shows below.

Figure C–3 Properties 
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Editing Folder Permissions
To edit folder permissions:

1. Click on the Security tab.

2. Give the user that the Application Pool runs as full control, and apply to all sub 
directories, as Figure C–4 shows below.

Figure C–4 Properties
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Verifying the IIS Directory Security is Configured Correctly
To verify IIS directory security:

1. Locate the WebDAV virtual directory, then right click and select Properties.

2. Verify that the directory has Write permission, as Figure C–5 shows.

Figure C–5 Virtual Directory

3. Click the Directory Security tab. 

4. Select Edit under Authentication and access control.

5. Verify that Anonymous access is enabled, as shown in Figure C–6.
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Figure C–6 Authentication

Enabling WebDAV in Apache: (Basic Configuration)
To enable WebDAV in Apache:

1. Install Apache 2.2.

2. Uncomment the following lines in httpd.conf:

LoadModule dav_module modules/mod_dav.so
LoadModule dav_fs_module modules/mod_dav_fs.so
LoadModule dav_lock_module modules/mod_dav_lock.so
Include conf/extra/httpd-dav.conf

3. Sample httpd-dav.conf:

...
DavLockDB "C:/Program Files (x86)/Apache Software
Foundation/Apache2.2/var/DavLock"
Alias /webdav "c:/webdav"
<Directory "c:/webdav">

Dav On
Order Allow,Deny
Allow from all

</Directory>
...

4. Create DavLock directory based on setting in httpd-dav.conf.



Configuring the Application

C-6 Agile Product Lifecycle Management for Process Install/Upgrade Guide

Configuring the Application
To configure WebDAV for a single server setup: 

1. Edit Environment Settings under 
PLM4P_HOME\custom\config\EnvironmentSettings.config

2. Map the following settings in the config to the appropriate directories/URLS. To 
test, you can enable directory browsing on the web dav virtual directory.

■ <config key=“PDFWorkArea” 
value=“https://demo.prodika.com/WebDAV/npdworkarea/”; />

■ <config key=“PDFWorkAreaUNC” 
value=“C:\WebDAV\NPDWorkArea\” />

■ <config key=“PDFCommentRepository” 
value=“https://demo.prodika.com/WebDAV/PDFComments”; />

■ <config key=“PDFCommentRepositoryUNC” 
value=“C:\WebDAV\PDFComments\” /> 

■ <config key=“OfficeDocWorkArea” 
value=“https://demo.prodika.com/WebDAV/npdworkarea/”; />

■ <config key=“OfficeDocWorkAreaUNC” 
value=“C:\WebDAV\NPDWorkArea\” /> 

To configure WebDAV for a multiple server setup:

1. Share the web dav directory as webdav on server A resulting in \\<server 
a>\webdav

2. Set appropriate share and security permissions as follows:

The user running app pool on server B must have RW share and security access to 
\\<server A>\webdav.

3. Use \\<hostname>\webdav\pdfcomments\ and \\<server 
A>\webdav\npdworkarea for UNC paths in config on server B. 

Note: If Apache is using a non-standard HTTP port, then you will 
need to reflect that in your environmentsettings.config file. For 
example:

https://demo.prodika.com:8080/webdav/npdworkarea/
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DInstalling National Language Support

This appendix contains instructions for installing and configuring National Language 
Support (NLS). 

Installing Language Support for Simplified Chinese, Traditional Chinese, 
Korean, French, German or Italian

As an optional installation step, customers may apply 6.1.1.0.0 National Language 
Support (NLS). 

Pre-Upgrade Checklist
1. Archive the previous installation.

2. Back up your current database.

3. Stop the Remoting Container service.

a. Open Services > Start > Administrative Tools > Services.

b. Locate the RemoteContainerService service and perform a Stop operation.

4. Stop IIS. From a command prompt, type the following:

> iisreset /stop
 

Apply Database Scripts
To apply the 6.1.1.0.0 scripts: 

(For SQL Server)
1. Open a command prompt and navigate to the directory where you unzipped the 

upgrade package.

2. Change directories (cd) to the Installer/ApplyScripts directory.

Note: Specific fonts are used when displaying these language 
characters in the UI as well as when printing. Verify you have the 
following fonts installed on the server: 

Simplified Chinese: SimSun

Traditional Chinese: SimSun

Korean: Gulim
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3. Apply the scripts using the following calls to the ApplyScripts.exe utility:

a. Apply the scripts to load Korean translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f v6.1.1_
Korean_LangPack.xml

b. Apply the scripts to load Simplified Chinese translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f v6.1.1_
Chinese_LangPack.xml

c. Apply the scripts to load Traditional Chinese translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f v6.1.1_
ChineseTW_LangPack.xml

d. Apply the scripts to load French translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f v6.1.1_
French_LangPack.xml

e. Apply the scripts to load German translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f v6.1.1_
German_LangPack.xml

f. Apply the scripts to load Italian translation:

> ApplyScripts -c "server=<database_
server>;uid=<user>;password=<password>;database=<database>" -f v6.1.1_
Italian_LangPack.xml

4. After the ApplyScripts call, you can confirm that the database upgrade scripts 
have been applied successfully when the system prompts you with the following 
message:

"Complete - with no errors"

(For Oracle Database)
1. Open a command prompt and navigate to the directory where you unzipped the 

upgrade package.

2. Change directories (cd) to the Installer/ApplyScripts directory.

3. Apply the scripts using the following calls to the ApplyScripts.exe utility:

a. Apply the scripts to load Korean translation:

> ApplyScripts -c "User Id=<user>;Password=<password>;Data 
Source=<datasource>" -dbvendor orcl  -f v6.1.1_Korean_LangPack-orcl.xml

b. Apply the scripts to load Simplified Chinese translation:

> ApplyScripts -c "User Id=<user>;Password=<password>;Data 
Source=<datasource>" -dbvendor orcl  -f v6.1.1_Chinese_LangPack-orcl.xml

c. Apply the scripts to load Traditional Chinese translation:
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> ApplyScripts -c "User Id=<user>;Password=<password>;Data 
Source=<datasource>" -dbvendor orcl  -f v6.1.1_ChineseTW_LangPack-orcl.xml

d. Apply the scripts to load French translation:

> ApplyScripts -c "User Id=<user>;Password=<password>;Data 
Source=<datasource>" -dbvendor orcl  -f v6.1.1_French_LangPack-orcl.xml

e. Apply the scripts to load German translation:

ApplyScripts -c "User Id=<user>;Password=<password>;Data 
Source=<datasource>" -dbvendor orcl -f v6.1.1_German_LangPack-orcl.xml

f. Apply the scripts to load Italian translation:

ApplyScripts -c "User Id=<user>;Password=<password>;Data 
Source=<datasource>" -dbvendor orcl -f v6.1.1_Italian_LangPack-orcl.xml

4. After the ApplyScripts call, you can confirm that the database upgrade scripts 
have been applied successfully when the system prompts you with the following 
message:

“Complete - with no errors”

Post-Upgrade Checklist
1. Start the Remoting Container Service.

a. Open Services > Start > Administrative Tools > Services.

b. Locate the RemoteContainerService service and perform a Start operation.

c. Verify that the RemotingContainerService started correctly.

2. Start IIS. From a command prompt, type the following:

> iisreset /start
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EInstalling BI Publisher

This appendix contains instructions for installing and configuring BI Publisher.

BI Publisher for Printing and Reporting
Oracle Business Intelligence Publisher (BI Publisher) has been integrated with the 
Printing and Reporting applications. Printing and Reporting have separate 
configurations settings, and BI Publisher can be configured for Printing, Reporting, or 
both. 

Requirements:  See "Installation Requirements" on page 1-1 for supported versions of 
BI Publisher.

When installing BI Publisher, you will be prompted to enter an administrator 
username and password for administering the BI Publisher reports. This username 
and password will also grant access to a BI Publisher web service used by Agile PLM 
for Process to processes printing and reporting requests. To enter these values into 
Agile PLM for Process, launch the Setup Assistant tool and enter the username and 
password for BI Publisher. For more information, refer to the Agile Product Lifecycle 
Management for Process Configuration Guide. 

Note that when setting up BI Publisher for Reporting, you will need to set up a 
database connection to the Agile PLM for Process database. This may involve 
installing relevant JDBC drivers, setting up the DataSource in BI Publisher, and 
configuring the connection string and database driver class. Refer to the Oracle BI 
Publisher documentation for details. 

Printing Using BI Publisher
To configure BI Publisher for Printing, you will need to update Agile PLM for Process 
configuration settings and set up BI Publisher to process the incoming data using BI 
Publisher’s report templates. 

Print data is sent to the BI Publisher web service as XML data; the relevant BI 
Publisher report template takes the incoming XML data and can then transform it 
using a custom XSL as needed. 

Note: The BI URL in environment variables has changed if you are 
using the new version, 11.1.1.x, of OBIEE with release 6.1.
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To Configure Agile PLM for Process:
1. Update the \config\environmentvariables.config file:

2. Update the \config\Extensions\PrintSettings.config file. This file contains the 
print configurations for the various print items, such as specifications, NPD 
printing, etc. You will need to update this file to setup a print manager using the 
BIPublisher and use it in the print items:

a. Open the \config\Extensions\PrintSettings.config.

b. Setup a new print manager using BIPublisher in PrintManagers section. We 
have supplied an example in that file but it is comment out. You can 
uncomment the section and then change it or create a new one according to 
your actual configuration of BIPublisher. The following example shows how 
to setup a print manager named "BIPublisherFORender":

<PrintManager id="BIPublisherFORender" outputExtension="pdf">
<Pipes>

<Pipe id="StandardXml" sequence="1" 
objectURL="Class:Xeno.Prodika.Printing.PrintPipes.XmlPrintPipeFactory,Print
Service"/>

<Pipe id="StandardTransformation" sequence="2" 
objectURL="Class:Xeno.Prodika.Printing.PrintPipes.XDocServiceTransformation
PrintPipeFactory,PrintService"/>

<Pipe id="BIPublisherFORender" sequence="3"
objectURL="Class:Xeno.Prodika.Printing.PrintPipes.OracleBIPublisher.v11_1_
1_5.BIPublisherFORenderPrintPipeFactory,PrintService">

<add key="EndPoint" 
value="@@VAR:Prodika.Print.BIPublisherIntegration.EndPoint@@"/>

<add key="ReportPath" 
value="/ProdikaPrint/ProdikaPrintFO/ProdikaPrintFO.xdo"comments="Overri
dable on the print template by specifying reportPathattribute"/>

<add key="ReportTemplate" value="FOTemplate" comments="Overridable on 
the print template by specifying reportTemplate attribute"/>

Key Value

Prodika.Print.BIPublisherIntegration.EndP
oint

For versions 10.1.3.3 and 10.1.3.4:

 
http://[hostname]:9704/xmlpserver/services/
PublicReportService

For version 11.1.1.5:

http:// 
[hostname]:7001/xmlpserver/services/v2/Secu
rityService|http:// 
[hostname]:7001/xmlpserver/services/v2/Rep
ortService

Note: Prodika.ReportService.SysUser and SysPassword are now set 
using the Setup Assistant. Refer to the Agile Product Lifecycle 
Management for Process Configuration Guide for instructions.
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<add key="ReportFormat" value="PDF" comments="Overridable on the print 
template by specifying reportFormat attribute"/>

</Pipe>
</Pipes>

</PrintManager>

By this configuration, we can set the correct version of the adapter connect to 
BIP services.

The value of the underlined part of the example could be one of the below:

– For BIPublisher 11.1.1.5:

objectURL="Class:Xeno.Prodika.Printing.PrintPipes.Ora-
cleBIPublisher.v11_1_1_5.BIPublisherFORenderPrintPipe-
Factory,PrintService"

– For BIPublisher 10.1.3.4:

objectURL="Class:Xeno.Prodika.Printing.PrintPipes.Ora-
cleBIPublisher.v10_1_3_4.BIPublisherFORenderPrintPipe-
Factory,PrintService"

– For BIPublisher 10.1.3.3:

objectURL="Class:Xeno.Prodika.Printing.PrintPipes.Ora-
cleBIPublisher.v10_1_3_3.BIPublisherFORenderPrintPipe-
Factory,PrintService"

The values of "ReportPath", "ReportTemplate" and "ReportFormat" should be 
set according to the actual configuration on BIPublisher server. They could be 
overriden by the values in "PrintTemplate" node.

c. Update the specification (or other print item) type you want to print to use the 
BI publisher print manager. You can add the following to an existing entry, or 
create a new entry:

printmanager="BIPublisherFORender" reportPath="Your custom 
BI Publisher report path"



BI Publisher for Printing and Reporting

E-4 Agile Product Lifecycle Management for Process Install/Upgrade Guide

To Configure BI Publisher for Printing:
Setting up BI Publisher for Printing involves creating a BI Publisher report, 
configuring its Data Model to link it to Agile PLM for Process, and setting up the 
possible layouts. In this section, an example report configuration is presented, but 
other configurations are possible. 

1. Log in to BI Publisher. For 10.1.3.3 and 10.1.3.4: 
http://<YourBIServerURL>:9704/xmlpserver/

For 11.1.1.5:
http://<YourBIServerURL>:7001/xmlpserver/

2. In the Reports tab, click the Shared Folders link.

3. Create a new folder (ex: ProdikaPrint).

4. In the new folder, click the Create a new report link on the left, enter a report 
name (ex: ProdikaPrintFO) and click the Create button.

5. Click the Edit link.

6. Click Parameters, then click the New icon.

Figure E–1 Parameters option, Parameter page

a. Make entries in the following fields:

Identifier— Enter DocKey. This is a required field.

Data Type—Select String from the drop-down list. This is a required field.

Default Value—Leave this field blank.

Parameter Type—Select Hidden from the drop-down list. This is a required 
field.

b. Click Save. 
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7. Click Data Model, then click the New icon, as shown in Figure E–2.

Figure E–2 PrintDataModel option, Data Set page

a. Make entries in the following fields:

Name—Name of the data model. This is a required field.

Type—Select HTTP (XML Feed) from the drop-down list. This is a required 
field. 

URL—Enter 
http://{application URL}/gsm/PopUps/docstream.aspx where 
{application URL} is the address of the application. This is a required field.

Method—Select GET from the drop-down list. This is a required field.

b. Click Add to display the Parameters Name and Value fields. 

c. Make the following entries:

Name—The name of the parameter that you created in step a. This is a 
required field.

Value (Parameter)—Select DocKey from the drop-down list. This is a required 
field.

d. Click Save. 
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8. Click Layout to set up the report layout.

a. In the Manage Template Files section, upload your XSL template to use. In this 
scenario, we created and uploaded a simple XSL “pass-through” file called 
ReportTemplate.xsl, as such:

<?xml version='1.0'?>
<xsl:stylesheet version="1.0" 
xmlns:xsl="http://www.w3.org/1999/XSL/Transform">

<xsl:template match="/">
<xsl:copy-of select="/" />

</xsl:template>
</xsl:stylesheet>

However, you can easily create your own transformation rules yourself.

b. Click New to create a new report layout, as shown in Figure E–3. 

Figure E–3 Layouts, FOTemplate option, Layout page

Note: You can create multiple layouts and then declare the desired 
layout in the PrintSettings.config file.
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c. Make the following entries:

Name—The name of the report layout. This is a required field. 

Template— Select XSL Stylesheet (FO) from the drop-down list. This is a 
required field.

Template Type— Select the Limit Output Format to radio button, and then 
select the PDF checkbox. This is a required field. 

d. Click Save.

Your report should now be available for printing. Make sure that the link to the report 
matches the reportPath value in the PrintSettings.config file. (While editing 
the report in BI Publisher, right-click on the View link in the top right and select Copy 
Shortcut to get the value).

If your Printing includes any images, such as logos, make sure they are available to BI 
Publisher, by adding them to the BI publisher directory. The location will depend on 
the path used.

Reporting Using BI Publisher
The Agile PLM for Process Reporting application allows clients to organize, configure, 
secure, and launch custom reports. The configuration is managed in the 
CustomerReportExtensions.xml located in the \Config\Extensions\ 
directory. Reports and their parameters are presented in PLM for user entry; their 
values are then passed to custom BI Publisher reports to process the parameters, query 
data sources, and generate the report.

To use BI Publisher for Reporting, you will need to update Agile PLM for Process 
configuration settings, set up custom reports in BI Publisher, and update the Agile 
PLM for Process Reporting configurations accordingly. 

For details on configuring custom PLM reports, refer to the Agile Product Lifecycle 
Management for Process Custom Report Configuration Guide.

To Configure Agile PLM for Process:
1. Update the \config\environmentvariables.config file:

Key Value

Prodika.ReportServer.URL For 10.1.3.3 and 10.1.3.4:

http://[hostname]:9704

 

For 11.1.1.5:

http://[hostname]:7001

Prodika.ReportService.URL Use one of the following:

Prodika.ReportService.OracleBIPublisher10_1_
3_3.URL

Prodika.ReportService.OracleBIPublisher10_1_
3_4.URL 
Prodika.ReportService.OracleBIPublisher11_1_
1_5.URL
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2. Update the \config\Extensions\CustomerReportExtensions.xml file to set up the 
custom reports for the Reporting application. Details can be found in the Agile 
Product Lifecycle Management for Process Custom Report Configuration Guide. 

To Configure BI Publisher Reports:
Refer to Oracle BI Publisher documentation for creating and setting up reports in BI 
Publisher.

Note: Prodika.ReportService.SysUser and SysPassword are now set 
using the Setup Assistant. Refer to the Agile Product Lifecycle 
Management for Process Configuration Guide for instructions.
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FSkill Set Requirements and
Recommendations

Skill Set
Refer to the following matrix for guidance on what skills are recommended for 
members of your technology team. 

Table F–1 Skill Set Requirements and Recommendations

Skill Set Description Resource

Windows Server OS Required skill for the management of the OS Systems Administrator

IIS 6.0/7.x Required skill for the implementation and 
management of IIS

Systems Administrator

SQL Server or Oracle Database Required skill for the implementation and 
management of the DB

DBA

Performance Tuning SQL Server 
or Oracle Database

Highly recommended skill for the DB monitoring 
and tuning of PLM4P specific to your environment 
and business use cases

DBA

SQL Required skill for reporting development

Recommended skill for triage and development

DBA

Developer

JScript Required skill for the development of Calculated 
Extended Attributes

Developer

C# Required skill for customization of the application 
suite using extensions, such as validations, workflow 
actions, etc.

Developer

XML Required skill for the development of extensions and 
printing

Developer

XSD Required skill for the development of printing Developer

BI Publisher or Microsoft SQL 
Server Reporting Services

Required skill for custom report creation Developer
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GInstallation Troubleshooting

This appendix contains a list common issues that may occur after installation.

Troubleshooting Tips
The following list details common issues and suggestions for solving them. 

1. How can I compare my recent build with an older build to see if configuration 
values have changed?

Tip: Use the Config Rollup URL to check the rolled up configuration settings for 
various applications. The URL is:

http://<serverName>/<appName>/WebCommon/AdminForms/ConfigRoll
up.aspx

2. Clicking upload when adding a DRL attachment causes the window to simply 
blink.

Tip: Ensure you’ve waited at least 30 seconds on the first attempt. 

Tip: Ensure the web.config for your .NET version has the machine key entry. 

3. Message displayed is “trust relationship could not be established”.

Tip: Verify that the Web site your using has a signed certificate. 

Tip: If not testing SSL DRL attachments, configure them to use HTTP and ensure 
the “Prodika.GSMInterApp.URL” property is using HTTP. 

4. Message displayed is “The remote certificate is invalid according to the validation 
procedure.”

Tip: Be sure to configure the DRL.WebServices.Login and 
DRL.WebServices.Password credentials using the Setup Assistant tool. The user 
specified should be an Agile PLM for Process user. For more information, refer to 
the Agile Product Lifecycle Management for Process Configuration Guide.

5. NPD edit-in-place documents are read-only.

Tip: The user connecting to the IIS share does not have permissions to the 
underlying folder on the server.  Grant full permissions by assigning the 
‘Everyone’ permission setting on that folder. If that solves the problem, lock down 
the folder with tighter permissions.
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6. The Browser keeps redirecting to incorrect URLs or keeps jumping from HTTPS to 
HTTP.

Tip: Make sure that the environmentvariables.config file has the right URLs. 

Tip: You can only have one HTTPS site on one machine. If you have more than 
one, it bounces back and forth between the two sites. 

Tip: Make sure that you are not using HTTPS in the URL to access a http web site. 
Using https in your URL will make the Server redirect your request to the default 
https Web site. 

Tip: Conversely, if the environmentvariables.config file is using https to access a 
http Web site, you would be redirected to the default https Web site incorrectly 

7. Navigation to any page in the application results in a blank page after migrating to 
another version or a new version of .NET is installed.

Tip: The wrong ASP.NET version may be registered with IIS. Run the “aspnet_
regiis.exe” utility with the “-r” flag.

8. The rich text dialog box is prompting me with security issues concerning scripts.

Tip: Ensure the page event and request validation are turned off.

9. What is drl.prodika.com? 

Tip: Make sure that you have the new URLs and https:.

10. I am prompted to login to every application.

Tip: Is the remoting container running? 

Tip: Ensure you are using the trust bridge in “EnvironmentSettings.config”.

11. I have installed and receive the following error, or something similar, when I start 
the remoting container or application:

"Exception Message: No more connections can be created. They are all being 
used."

Tip: This usually indicates a problem with the connect string. Verify your values 
are correct and that the connect string is syntactically correct. Also, when 
connecting to an Oracle database, make sure you have added the adapter factory 
config key to environmentsettings.config. Please read the section titled, 
"Configuring the Oracle Database Connection" on page 2-12.

12. I have upgraded and receive the following error when I start the remoting 
container:

"Xeno.Prodika.Common.ProdikaConfigurationException: Could not parse 'factory' 
attribute into an object on service tag ---> System.BadImageFormatException: 
Could not load file or assembly 
'file:///E:\PLM\RemotingContainer\System.Data.dll'" 

Tip: We removed all DLLs from the %PLM4P_HOME%\remotingcontainer\ 
directory. This error indicates you performed an overlay on top of an existing 
%PLM4P_HOME%. Please read the section titled, "Install the Agile 6.1.1 Upgrade 
Software" on page 3-6.

13. I have upgraded and receive an error that it could not load the 
Oracle.DataAccess.DLL.
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Tip: This is generally because you have the wrong Oracle client installed. Prior to 
6.1.1, we only supported running PLM4P as a 32-bit application, regardless of OS 
bit level. Thus, it was required to download and install the 32-bit Oracle database 
client. In 6.1.1, we now offer the ability to run the application as a 64-bit 
application on a 64-bit OS. If you switched from 32-bit to 64-bit, you will need to 
install the 64-bit Oracle database client on your server.

14. When I try to run applyscripts, I receive an error that it could not load the 
Oracle.DataAccess.DLL.

Tip: See 13.  The Oracle client needs to match the OS. Additionally, applyscript 
does not need to be run from the server.  If there is another workstation or server 
where you know applyscript works, you can try running it from there.
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